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Things to Mastering More Advanced Appendices

Remember the Basics Techniques

About this Manual

Notation Conventions

The contents of this manual are classified according to the following symbols.

1) IMPORTANT

e The “Important” sections contain operating precautions or important topics.
Ensure that you read them.

@ HINT ]

e The "Hint"” sections contain procedural suggestions and tips for your convenience. Read them as
necessary.

Operating Environment

e This manual uses Windows Vista screen shots and procedures in the explanations.
The screen shots and procedures may appear slightly different if you are using
another version of Windows.

e The displayed screens and procedures may also differ slightly from the examples
depending upon the camera or printer model in use.

e The explanations in this guide are based on the premise that a Canon compact
digital camera will be used with the software.

Word Searches

This document is provided as an Adobe Reader document. Use Adobe Reader’s Search
functions to find specific words or phrases that you recall but cannot find. To access
this function, in Adobe Reader click the [Edit] menu and select the [Search] option.

If you are using Adobe Reader 8 or later, you can also perform searches with the [Find]
function right on the toolbar.

EAdubeRaadﬂ
File Edit View Document Tools Window Help
= @, @ % /™ @® wx - (] Fnd ———— Input search text here
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Precautions for Connecting the Camera to the Computer

e \WWhen connecting the camera to the computer with an interface cable, make sure to connect
the cable directly to the computer’s USB port. The connection may not operate correctly if
you attach the camera to the computer via a USB hub.

e The connection may not operate correctly if you are using other USB devices, excluding
USB mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

* Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

* Do not allow the computer to go into sleep (standby) mode while a camera is connected
via the USB interface cable. If this does happen, do not disconnect the interface cable. Try
to awaken the computer with the camera in the connected state. Some computers will not
awaken properly if you disconnect the camera while they are in sleep (standby) mode. Please
refer to your computer manual for instructions regarding the sleep (standby) mode.

e Do not disconnect the camera from the computer if CameraWindow is displayed on the
screen.

{1) IMPORTANT

e You are recommended to use an AC adapter (sold separately) when connecting
to a computer. Ensure that you use fully charged batteries if you cannot use an
AC adapter.

* See the Camera User Guide for procedures on connecting the camera to the
computer.
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Things to

Remember

The Two ZoomBrowser EX Windows

Windows That Communicate With the Camera and Manage Images

The following two windows are the main ones used for ZoomBrowser EX procedures.

Transfer window, which opens when a camera is connected.
CameraWindow

lfe,

You can transfer all or a selection of images from the connected camera.

—— T— —— J
CameraWindow closes and the screen changes
after the images are transferred from the camera.
Organizing window for transferred images.
Main Window g
e e e e > — foomBrowse
;] — 9‘ - e e T TR [ rE¥
ryre—| | O R R Double-click this icon
= on the desktop.
. : Double-click p— —
i o -| - > Tt oREL N an Image [ R
You can view, edit and print the images in the The Viewer Window that
computer. appears when you view
an image. J

@ HINT

Use the Help Function
The il (Help) button or Help menu is available in most CameraWindow and ZoomBrowser EX windows. It
is there for when you are unsure how to proceed.

€. CIXEITD < ¢ >
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ZoomBrowser EX’s Main Window

How to Display the Main Window

The Main Window will display after camera images are transferred and
CameraWindow closes. You can also display it by double-clicking the
ZoomBrowser EX icon on the desktop. TN
r Ex
Names of the Main Window Parts
Menu Bar Function Buttons Display Control Panel
I
File Edit View Took Internet Helpy —
o | Viewlnage o~ | Propeties || ShdeShow | P Sewch 7] Delete (T Rotate ’
[@ Acquile b Cameia Sellings J I.,_mm
Task Buttons Y 0T G0 0 M-a-|Ma | = o .
Selects tasks to E'E, ‘J‘
perform. b 2 —
fﬂ-' Expest - | A\
. ik & Ll .
ST
Last Acquired Images = Letfeausdinse:
Displays the lastimages [} =5 & one
_-:lﬂ i
transferred. mnwmf;‘
'._a People
“Ba Scenery
O bents

’ Fawonte Folders | AN Folders|
Folder Area (5 B® Prtures -
| b 2009 0807

SE|§'CtS|a folder g
. | 2009 06 07

to display sl I
L 2009 08_11 =

| =
\

Selected Bems: 1

Browser Area
. , . Icons that indicate
: Image recorded using the camera’s Stitch Assist mode image properties display

: RAW image around images, as
shown on the left.

Properties Icon (Displays image properties)

: Movie

: Image with sound memo attached

: Protected image

- Image recorded using the camera’s AEB function

BOBS0EE

: Rotated image (rotated in display only)
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Remember

How to Perform Tasks

Selecting Tasks and Task Window Procedures

Many ZoomBrowser EX functions can be accessed by selecting a task in the Main
Window and following the instructions in the guidance section of the new window.
For further details on the functions, refer to the “List of Available Functions” (p. 51) in
the appendix.

" Select a task.

------------------------ | Viewlmage - | Prepertes EMM J;m:n HM&M
| W] Arpon b Covrmen Sttrge: | Zoom Mk | Sl e | o] >
M vewscins J 00811 Q

The major steps for the
task appear here.

Follow the steps in order.
You can return to a

f previous step.

An overview for the
selected task appears here.

ZoomBrowiar EX dete
Solact the editing funcion: ;‘:ﬁmﬂmh;ﬂ:ﬁ
® Fod Eye Comeion.. I
U Ao Adpustment. “row can alsg edithe £
" ColoyBrighiness Adystmer. e
" Shorpnass.

& T,

) bnsan Teat

2 Editwith exiemnal imoge editor.

Cancels the procedure and
returns to the previous
window.

2 Follow the instructions
to perform the task.




Things to More Advanced Aopendices
Remember Techniques PP

Transferring Images

Transferring Images by Connecting the Camera to a Computer

Transfer the camera images to the computer.

1) IMPORTANT

* The instructions in this software manual assume that you have correctly installed
the software. See the Camera User Guide for software installation procedures.

¢ For details on how to connect the camera to a computer, refer to the Camera
User Guide. Please also refer to “Precautions for Connecting the Camera to the
Computer” (p. 3) at the beginning of this guide.

e With some versions of Microsoft Windows, CameraWindow may not open when
the camera is connected. In this case, double-click the ZoomBrowser EX icon on the
desktop to start ZoomBrowser EX and open the Main Window. Click the [Acquire &
Camera Settings] task button, followed by [Connect to Camera].

" Connect the camera to the computer
with the supplied interface cable. ="

2 Turn on the camera power, set it to
playback mode and prepare it to
communicate with the computer.

| AutoPlay (==
3 When a window similar to the one at . Canon X000000KKX
the right appears, click [Downloads <)
Images From Canon Camera using Canon ] Always do this for this device
CameraWindow]. i s

With Windows XP, click [Canon 7 Rt
CameraWindow] then [OK] in the AutoPlay

window.

J: =i Downlpade Images From Canon Camera
L= = il

imo Canon Cameraisinde
Using Lanon Lameraiimao!




Mastering

the Basics

CameraWindow (Menu Screen)

4 Click [Import Images from
Camera], and then click
[Import Untransferred
Images].
Only images that have not yet
been transferred will start to
transfer.

After you click [OK] in the
dialog that indicates the transfer
is complete and close the

CameraWindow screen, the
transferred images will display in
the Main Window.

T T— L%
L e T e T |
e [+ ) G0 - A

You can select the newly
transferred images by their
shooting dates or My Category
(select models only) classification.

# : Folders containing
newly acquired images

* Images from memory cards with large numbers of images (more than 1,000) may not transfer
correctly. If this happens, please use a memory card reader to transfer (p. 11).

e Movie files take time to transfer since the files are large.

~ @ HINT |

Changing the Transfer Destination Folder

The default settings save transferred images into

the [Pictures] or [My Pictures] folders. To change the
destination folder, click the [E3 button shown on the
right in Step 4 as described above, then click the [Import]
button. In the [Folder Settings] tab, click [Browse] to
complete settings in the screen currently displayed.

M Table of Contents )
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~ @ HINT \

Select Images to Import
To transfer only a selection of images from
the camera, click [Import Images from
Camera] in CameraWindow (menu screen),
then select images in the image transfer
screen, and click  (Import).

Import All Images
To transfer all images on the camera,

click [Import Images from Camera] in
CameraWindow (menu screen) then, [Import
All Images].

Automatically Transferring Images on
ZoomBrowser EX Start-Up

To automatically transfer images when
CameraWindow starts up, click the button
shown on the right in CameraWindow
(menu screen), then click the [Import]
button, and the [Auto Import] tab. Add

a checkmark to [Start importing images
automatically when this software is
launched.].

Transferring from a Memory Card Reader

An action selection window will open when you insert a memory card into the memory card reader. If you
select [View/Download Images Using Canon ZoomBrowser EX], ZoomBrowser EX will start and display the
following window. Use this window to perform the transferring procedures.

ZoomBrowser EX

Transfers all images that have not yet been

transferred.
 Letsyouselectand i
[ e ot Allows you to select and transfer images.
Print Menu Prints images.

Configures the transfer folder and
other settings.

W( Table of Contents )
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Printing

Printing a Single Image on a Single Page

Prints one image per page.

@ HINT
[Printing Movies ]

Movies cannot be printed, but you can print still images saved from movies.

" Click the [Print & Email] task button in the Main
Window.

2 Click [Photo Print].

Indes: Pririt

3 Confirm that [1. Select
Images] is chosen and select

images for printing.

( Table of Contents )
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the Basics

4 Click [2. Printer and Layout Settings] and set the categories as desired.

Sets the printer, paper Click here to crop and print a portion of an image.
size and borderless

printing settings.

Click here to insert text
onto an image and print.

Add or Modify tet o pring with

Ill thiss photo

Insar Tt

c [Femove umwantad regions

: | o
- v

Teim Imnga

Madia Typs:
[Fiain Paper
Papes Sive
Lot
%] Borderless

Ehooting DateTime
Dot Time.  e—

Fiopfring,

i L)E  Fhota 1/3 ﬁplnl: 1 % Tosal: 3 pages
| ! =

[ cpmons |l Pt ] [ comm |

Sets the shooting date/time imprint settings.

Click [3. Print].
Printing will start.

@ HINT

Printing Using Other Software

If you have specialized printing software installed on the computer, you can also use it to print the
images. Click the [Print & Email] task button in the Main Window, followed by [Print Using Other
Software].

(A ) Table of Contents ) « 13 )
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Index Print

Prints an index of the images.

" Click the [Print & Email] task button in the Main =
Window. —
Esport
@ Prird & Email
1) CANON MAGE GATCWAY
2 Click [Index Print]. {ﬁ) —

3 Confirm that [1. Select
Images] is chosen and select

images for printing.

Tnare (fude | ool g |
o L]

OG-0 .

L it i

()
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the Basics

4 Click [2. Printer and Layout Settings] and set the categories as desired.

Select an image to
rotate or trim.

Click here to crop a
portion of the selected
image and print it.

Rotates selected
images.

Sets the printer and
paper size settings.

M

LEES TSNS s ?_lr'

Media Type:

[PomFoper <]
Pager Size: .
[Lomer )
Crigniation

& Parrait ) Lendscaps

Copres 1 o
Taial 1 pages

Sets the number of Configures the printing of the shooting information,
rows or columns. comments, headers, footers or page numbers.

5 Click [3. Print].
Printing will start.

(14 ) Table of Contents ) < 15 >
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How to Use CameraWindow

First Menu Screen to Open

This screen appears when the camera is connected to your computer.
Click each button to display the available options.

Displays in-camera
memory card
information. Displays camera information.

Starts operations for
transferring images from the
camera to your computer.

Starts operations for
protecting, rotating, and
deleting images. Also transfers
images from your computer to
the camera.

Starts operations for setting
the camera start-up screen,
start-up sound, and various
camera sounds. For more
details refer to “My Camera
Settings” (p. 45) in “More
Advanced Techniques”.
This menu may not appear
depending on your camera
model.

@ HINT

Customizing CameraWindow Functions

If you click gl as shown in the upper right of the screen, you can customize various functions to make
CameraWindow easier to use. You can change the automatic transfer settings, the start-up screen that
appears when starting CameraWindow, and the transfer destination folder.

Y Teble of Contents ) - 16 )
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Image Transfer Screen

This screen appears when you click [Import Images from Camera] on the Menu screen,
then click [Select Images to Import]. Select the image you want to transfer and click
to transfer the image to your computer.

Viewer Window (thumbnail display) E Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).

Returns to the Menu screen. Changgs thumbna?l si;e
(when in thumbnail display).

= E—— Closes CameraWindow.
Impeart Images from Camera e I T

A mages (XX - BnE Switches between window display
modes.

[ 28] Thumbnail display

Preview display

Untrsnsfemed Images 236 f 238

B3 Allimages (1)
] Untransfarred Images (XXX}

v &2 Oute Shot -l Full screen display
* 0 2009 (xxx) o . .
+ 1 on pxx) Double-clicking an image switches

£3 07 pxxa to preview display.
[ o8 (xxx)
1 0= (xxx)
[ 10 e This mark appears on images that

. QI 2t peg have not yet been transferred.

Transfers the image chosen
in Viewer Window to your

Folate lolhe  Haksle ba the

et gt ) computer.

Images on the camera
that match the selected
filter display in the area

to the right. oo Oelects all images.
[st=]

Rotates chosen images :
£) ‘ 0‘ 90° to the left or right. ————— The background of chosen images turns blue.

Cancels image selection.

€> <




Organize Images Screen

This screen appears when you click [Organize Images on Camera] on the Menu screen,
then click [Organize Images]. Clicking a folder on the left will display all images within
the folder as thumbnails (small images) on the right of the screen.

Viewer Window (thumbnail display) E Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).

Changes thumbnail size
(when in thumbnail display).

Returns to the Menu screen.

 Uiities CamersWindow DC - Closes CameraWindow.
Organize Images on Camera o T
I Gl Oophc e = Switches between window display
—EE modes.
Untransferred Images: 236 [ 238 [EI Thumbnail dlsplay
0 Alllmages (X)) Preview display
] Untransfarred Images (XXX}
* £53 Cute Shot -l Full screen display
* 0 2009 (xxx) C . . .
+ B 09 pux) Double-clicking an image switches
£ 07 o to preview display.
[ o8 (xxx)
[ o9 (xxx)
[ 10 e This mark appears on images that
0O 11 pecg) have not yet been transferred.
» D Fodder
Deletes the image chosen
" \e? in Viewer Window.
et gt
Images on the camera Protects/cancels protection
that match the selected for the image chosen in
filter display in the area Viewer Window.
to the right.
o) Transfers images on your
(=]

. computer to the camera.

Rotates chosen images
2 | 0 90° to the left or right.

The background of chosen images turns blue.

(1) IMPORTANT

e Clicking  will delete the image from the camera. Exercise adequate caution, as
you cannot retrieve the deleted images.

((A)ebee of Contents ) « 13 B>
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How to Use ZoomBrowser EX

Main Window

This is the main window for performing tasks in ZoomBrowser EX.

Slide Show — Search
Displays the selected images in Performs searches on images.
succession in the window.
— Delete
Properties Deletes the selected images or folders.
Displays information about a ¢ Deleted images are sent to the Recycle Bin on
selected image. the desktop.

¢ The association between a sound memo and
an image cannot be recovered from a file
restored from the Recycle Bin.

View Image
Displays the selected image
in the Viewer Window.
— Rotate

Rotates a selected image.

e Click the [Edit] menu and select [Rotate

Task Buttons
Selects a task to perform.

Last Acquired Image According to Rotation Information] to
You can check images rotate the original image as well in the
by shooting date or My displayed direction.

Category.

Display Mode
Selects a display mode
for the Browser Area.

Display Control Panel
Configures the settings
for displaying images in
the Browser Area.

Browser Area
Displays the images in

ool s R an index list.
(B 3
4. 2005 08 07 |
& 200508 08 £
L. 202908 09
& 20090810
[| Bwmosun
[l

Selected kems 1

Folder Area

Selects a folder to display.

® You can register folders you use often as Favorite Folders ( E ). Register by clicking [Add].
To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

(Aot of Contents ) < 19 )
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Display Modes

Select a browser area display mode to fit your purposes.

o k| ke | B b e L (B
- @ o-8-{ e - — DOQ [ |

|
Zoom Mode: suited for Scroll Mode: allows Preview Mode: allows the
surveying many images. thumbnails to be viewed at a image information to be read
size suited for easy viewing. while viewing the image.

@ HINT

Magnify Thumbnails to Check Images

In zoom mode or scroll mode, positioning the mouse pointer over a thumbnail causes the image to
appear at a higher magnification in a Mouse Over window. You can also set the Mouse Over window to
not show in the (Show Information) menu.

Display Control Panel

This panel adjusts the display settings for the Browser Area.

Fit to Window
Changes the thumbnail size
to fit them into the window.

Selection Menu Select Button Display Size
Click this to select/deselect all Use this to select images Changes the size of the
images in the Browser Area. in Zoom mode. thumbnail in the Browser Area.

;- 0-1m
QOO0 |0~ |[k]|x = | o £ Fier >

Show/Hide Image Information Menu |— Scroll Button Filter Tool Menu
Select here to show/hide such image Use this when in Displays only images
information as the file name or shooting zoom mode to move that correspond to
date or rating beneath the the displayed portion specific conditions.
thumbnail. of the image (drag

inside the browser
Zoom Button area).

Use this to zoom in
and out on an image.

< = >
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Browser Area Tasks

~ Change the Folder Level — Change the Display Size
The level of folder displayed can be changed with the You can change the
following procedures. display ratio (Zoom mode)
* In Zoom mode, position the mouse cursor over the or thumbnail size (Scroll
folder and click the [z=d icon when it displays. mode) with the slider.

« In Scroll or Preview mode, double-click the | icon.
e To advance to a higher folder level, click the 0 icon.

Select Images

Clicking an image in the Browser Area selects that
image. To select multiple images, hold down the [Ctrl]
key while clicking images, or hold down the [Shift] key
and click a starting and ending image to select a range
of adjacent images.

Display Images

Double-clicking an image in the Browser Area (or
selecting the image and clicking (View Image)),
displays it in the Viewer Window.

Move, Copy Images

To move an image between folders, drag it over the
destination folder and release the mouse button.

To copy an image, hold the [Ctrl] key while releasing
the mouse button as above.

You can also use the same procedures to copy images
between Windows Explorer and the Main Window.

Create New Folder
To create a new folder in the Browser Area,
click the [File] menu and select [New Folder].

~ @ HINT |

Right-Click Context Menus

Right-clicking over a window or image displays contextual menus. These menus contain the functions
available in the current context as well as other convenient functions. Use the right-click menus to
increase your efficiency.

Using the Navigator

If you change the displayed zoom factor in Zoom Mode, a Navigator Window that shows the current
position will appear. In the Navigator Window you can change the position by dragging 4 or clicking
inside the window.

) < 2 >
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the Properties button. The
the Preview Mode.

Properties Window does not display in

Modified: 8/11/2009
File Size: 470.6 KB
B e Size: 1500 % 1200
% Drata Type: JPG
Sound: |:|
Shows or hides categories. [ TR | [ Protect . Protect

Fath: C:AU sershmmm Picturesh 200308 11 Prgvents an image from
~ being overwritten or deleted.
(%] File Marme:
File Name IkG_00071
The file name can
€ e hame ca Star Rating and My Categony:
be changed. me - Comment
o L —
AL e ‘| You can type a comment here.
. ’ Carnrment: '
Star Rating and My .
Category e — Keywords
Sets the rating for an l L ol Sets the keywords used in
image. — — - searches.
Kepwards:

An icon will display if a

My Category is set.

Brightness Histagram:

Shoaoting |nfarmation:

Brightness Histogram

A graph of the highlights and
shadows distribution in an
image.

Shooting Information
Displays detailed information,

[tern Mame Walue =

File Marme MG 0001 JPE 3 such as the shutter speed and
Camsia Medel Narma | Canph Saoae 1 exposure compensation setting.
Shooting Date/Time  8/11/2003 3:15:22 AM The camera model will determine
Shooting Mode At what information is displayed.

T [Shutter Speed) 1/250

Ay [Aperture Valug] 71

Light ketering Center Weighted Avg. |

J{

[ < Previous Meust »

Image Selector Buttons
When multiple images are selected, you
can switch between images that display
information in the Properties Window.

(‘.‘ { Table of Contents
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Viewer Window

Double-clicking an image in the Main Window displays it in this window.

Change the display magnification.
Zooming in displays the Navigator window
to show the relative position on the image.

Edit an image.

Display the shooting information.
You can configure the information display by clicking
the [Tools] menu and selecting [Preferences].

L D || -
ot | megmwenly

¥ (2 m m &=
L

Display multiple
images side by side.

Shooting

Display at full information
screen size.
Set the Star Rating.

=TS  w—
e The following window will appear when a movie is displayed.

RO

G oS 4 ot - = 02 M m @\

Tl B | ot or ot | M temmsilimage B8 Cunbhovie | MASOOTMION 0 /1)
YOu can extract s You can cut

stills from movies.

portions at either
end of a movie clip.

You can control movie
playback and sound
volume.

e The [Display Original Image] button will display beneath RAW images in the Viewer Window. Click this
button to display the converted image in the Viewer Window.

(A ebre of Contents )
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Techniques

Editing Images

(1) IMPORTANT

* The original image will be overwritten after an image is edited unless the file
name is changed before saving it. To preserve the original image intact, change
the file name when saving the edited image.

e This section introduces the procedures started by clicking the Edit task button. Images can also be edited in
a similar way by clicking the [Edit] button in the Viewer Window.

Red Eye Correction

— a ——

Restores eye appearance to the original color when light reflected from the flash
makes them appear red.

@ Proceduires \

] Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].

7 Select an image.
e Click [Start] when Auto mode is selected. 3 [2. Select Editing Tool]
e Switch to Manual mode if Auto mode cannot correct the 4 [Red Eye Correction]
image, and select the location of the eye to correct. o
5 [3. Finish]
* Movies and RAW images cannot be
edited.

Auto Adjustment
Automatically adjusts the image color balance and brightness.

@ Procedures\

] Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].

Select an image.

[2. Select Editing Tool]
[Auto Adjustment]

[3. Finish]

e Movies and RAW images cannot be
edited.

(A Teble of Contents ) <« 2 p)
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Color/Brightness Adjustment

You can adjust image color balance and brightness using a variety of methods.

Brightness, 1 N
@ E 6 Procedures
Contrast | Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]

[Color/Brightness
Adjustment]

5 [3. Finish]

® Movies and RAW images cannot be
edited.

A WN

Level AdjustmentJ

Tone Curve Adjustment J

Adjusting Sharpness—-Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people
and objects.

@ Procedures )

] Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].
Select an image.

[2. Select Editing Tool]
[Sharpness]

[3. Finish]

* The Unsharp Mask [Radius] is the size
at which the outline is detected and the
[Threshold] is the standard value at which
the outline is determined.

* Movies and RAW images cannot be
edited.

ONWN
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Trimming-Cropping a Portion of an Image

Use this to delete unnecessary portions of the image and leave only the necessary
portions.

@ Procedures \

] Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].
Select an image.

[2. Select Editing Tool]
[Trim]

[3. Finish]

® You can also input values or an aspect
ratio to specify the trim area.

e Movies and RAW images cannot be
edited.

O NN

Inserting Text

Use this to insert text onto the image.

@} Procedures\

] Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].

Select an image.

[2. Select Editing Tool]
[Insert Text]

[3. Finish]

e Placing a checkmark in the [Antialias] box

causes the text edges to blend in with
the underlying image.

* Movies and RAW images cannot be
edited.

You can freely adjust the font,
size, color and text attributes.

ONWN
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Using Other Editing Software

If you register another image editing program with ZoomBrowser EX in advance, you
can use that software to edit an image selected in ZoomBrowser EX.

Registering an Editing Program

@ Procedures \

| Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].

Select an image.
[2. Select Editing Tool]

[Edit with external image
editor]

[Manage List]

it can be started from
within ZoomBrowser EX.

r =

ZoomBrowser EX Ot_h(_-zr L)
Editing Program

Register the program so J

O A WN

Editing Images with a Registered Editing Program

@ Procedures \

| Select a task from the left
side of the window (p. 8):
[Edit] and [Edit Image].
Select an image.

[2. Select Editing Tool]

[Edit with external image
editor]

5 [3. Finish]

* The shooting information may be lost
from images recorded with the camera
and then processed and saved with
another image editing program.

e Movies and RAW images cannot be
edited.

N OON
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Attaching Sounds

You can add sound effects or background music to images and play back the sounds.

Adding Sound

@ Procedures )

] Select an image.

2

File( Edit YView Tools Intemet Help

[Edit] and [Add/Remove
Sound].

e \WAVE type sound files (extension
“.wav") can be attached to images.
e Attaching a sound file to an image results

in the selected sound file being copied
into the same folder as the image file.

Symbol displayed on image

thumbnails to which sound
files have been addey
p

Playing an Image Sound File

@ Procedures \

| Select an image.

2

( Edit Jview Tools Intemet Help

=
i

[Edit] and [Play Sound].

(A) « 23 B




More Advanced

Techniques

Creating Panoramic Images—PhotoStitch

You can create wide panoramic images by moving the camera slightly when recording
a series of images and merging them into one image.

% Procedures\

| Select a task from the left
side of the window (p. 8):
[Edit] and [Stitch Photos].

e Movies and RAW images cannot be
edited.

Use the PhotoStitch program
to create panoramic images.

@ HINT

Using the Stitch Assist Mode

If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the
image order and merge direction, making it easier to merge the images. (Some camera models may not
feature the Stitch Assist mode.)

(1) IMPORTANT

e If an “insufficient memory” message appears, try one of the following methods
to solve the problem.
* Close all other applications other than PhotoStitch.
e Reduce the size or number of images to combine.
e In the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce
the size.

(A Tebvle of Contents ) < 25 p)
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Editing Movies

You can create original movies by linking movie clips and still images.
You can even add titles and other text, background music and various special effects
to the movie.

@ e} Procedures )
OO OO | Select a task from the left

e B side of the window (p. 8):
llllllllllllllllllll-lll [Edit] and [Edit MOVie].

"3! "QF "‘; * \When editing movies (MOV) with a size

REEEEEEREEREENERREEERSR of 1280 x 720, up to 15 files can be
joined together to create a longer movie.

~ @ HINT N
Recordable Movie Length
e The length of movies you can save when you select MOV with Movie Size Max. Length
[Save image type] is shown at right. A message will appear if you 1920x1080 10 minutes
try to save a longer movie. Reduce the length or size of the movie 1280x720 20 rinutes
if this happens. -
640x480 30 minutes
320x240 60 minutes
\ y,

(1) IMPORTANT

e Movies edited with this function cannot be transferred back to the camera.
e Saving movies takes time, especially MOV type movies selected with [Save
image type] takes a considerable amount of time.
Ex: A one minute 1280x720 movie takes approximately 9 minutes to save.

=
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Things to
Remember

Mastering
the Basics

More Advanced

Appendices

Converting RAW Images-Digital Photo Professional

You can convert RAW images to JPEG and TIFF images.

Digital Photo Professional’s Main Window

WRGE igh qualy

Aecpe s

Fhemiar ofimagen B

{urrbar o tincied images

Selects folders containing images.

Digital Photo Professional’s Tool Palette

Brighiness adjusiment

d

| Whiie palance adjustment

[

Iﬂhu::ﬂllinw

| Picture Styie

- dtangard

You can adjust all three RGB channel
levels together or separately with the
Tone Curve.

Reduces noise that occurs when
shooting night time scenery, or
when shooting at a high ISO speed.

i Adjusts the brightness, white

‘Contrast (0}
Highlight {0}

‘Shadowi(0)
Linwar

Cobar tone:{0)
Colar sahurlicn {0)

SharpnezsiT)

balance and picture style.

— Adjusts the contrast, color tone,
color saturation and sharpness.

€D

O

Select a task from the left
side of the window (p. 8):
[Edit] and [Digital Photo
Professional Process RAW
Images].

Select a RAW image in
Digital Photo Professional’s
Main Window.

Click E

(Edit image window).

Adjust the image brightness
and white balance in the
tool palette.

* The modified contents (the
information for image processing
requirements) are saved along
with the image as a “recipe”.

e With Digital Photo Professional,
you can adjust images to achieve
the best results for your desired
scene or subject by specifying a
picture style.

e The items available to be modified
differ depending on the camera
model.

[File] and [Convert and

savel.

e After setting the file type, size,
and destination folder, click [Save].

* Only RAW images compatible with Digital
Photo Professional can be processed.

e Ensure that you use the RAW image
conversion software included with your
camera.

< 3
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Techniques

To print, using Digital Photo Professional, select an image in the Main Window, then
click the [File] menu and select the print function. Digital Photo Professional offers the
following printing methods.

Printing Method Description

Single Print Automatically sets the layout for printing a single image on a single page.

Detailed Setting Gives you the freedom to set the layout, add titles, or print with shooting information.

Prints a line-up of multiple images on one page (also allows you to select the number of

Contact Sheet images, layout, and add titles).

(1) IMPORTANT

e RAW images can only be captured on certain camera models that list "RAW" as one of
the data types included in the “Specifications” section of the Camera User Guide.

e Only RAW images compatible with Digital Photo Professional can be processed. Check the
Data Type item of the Specifications section of the Camera User Guide for compatibility.

* For a more detailed explanation of operating procedures, download the Digital
Photo Professional manual (PDF format) from the Canon website.

~ @ HINT N

About RAW Images

RAW images contain the data captured by the camera’s image sensor without modification. Since

they contain raw data that differs from the usual JPEG images by not having any image adjustment or
compression processing performed in the camera, they can be converted on a computer with a lossless

process.
Processing in the Camera Processing by Computer
S, Image?\djusﬁent
Standard Image . . .
. Can be used with general programs.

Capture Compression JPEG Image ¢ Image is subject to degradation when

Image sensor Image adjustment adjusted because it has been compressed.

data from & compression

Digital Photo Professional

shutter release | automatically performed RAW Image Processing

RAW Image (Image Adjustment)

Capture (RAW Image)—> . JPEG Image,
( Compression ) TIFF Image

* You can view the image while making
adjustments without worrying about quality
loss.

e Processing with Digital Photo Professional
is required to view the images with general
programs.

(A abie of Contents ) = S
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Exporting
Changing Image (Stills) Sizes and Types

You can change an image’s size and format when exporting it so that it can be
published on the Internet or attached to an email message.

@ Procedures )

| Select a task from the left
side of the window (p. 8):
[Export] and [Export Still
Images].

* You will lose the shooting information
if you save images as a type other than
JPEG.

Changing Movie Sizes and Types

You can change a movie's size and format when exporting it so that it can be
published on the Internet or attached to an email message.

@) Procedures \

] Select a task from the left
side of the window (p. 8):
[Export] and [Export
Movies].

e You can also use this function to rotate
movies.

(1) IMPORTANT

e Exporting movies may take a
considerable amount of time.

G0 ) < 3 )
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Extracting Stills from Movies

You can extract and save stills from your favorite frames recorded in a movie.

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII (@ Procedures\

rﬁl E! .-3! :El' | Select a task from the left

lllllllllllllllllllllllllllllllllllll SldeOfthEWindOW(p- 8):

[Export] and [Extract frames

from a movie].
Extract your best

shots as stills

Exporting Shooting Information

You can export the shooting information recorded with an image, such as the shutter
speed and exposure, as a text file.

@ Procedures\

| Select a task from the left
side of the window (p. 8):
[Export] and [Export
Shooting Properties].

failed photos or compare the
settings for several images.

Ascertain the causes of J

(A ebre of Contents ) < u p)
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Creating Computer Screen Saver Images

You can export images to serve as computer screen savers.

\ @) Procedures \

| Select a task from the left
side of the window (p. 8):
[Export] and [Export as a
Screen Saver].

LZ7Z

Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

@ Procedures )

] Select a task from the left
side of the window (p. 8):
[Export] and [Export as a
Wallpaper].

Y Teble o Contents ) < 35 p)




More Advanced

Techniques

Saving to CDs

You can save images along with their shooting information to CD-R/RW discs.

?} Procedures\

| Select a task from the left
side of the window (p. 8):
[Export] and [Backup to CD].

or distribute your vacation

photos on discs.
— -

Back up important images J

(1) IMPORTANT

e This function can only be used with computers that satisfy the following
requirements:

e Equipped with a CD-R/RW drive as standard equipment
e Writing to the CD-R/RW drive operates correctly with Windows

e |f a window similar to that shown to the right appears when
a new CD-R/RW disc is placed in the drive, click [&3s ((Cancel] - _
when using Windows XP) to close the window. @ DVD RW Drive (G)

Always do this for blank CDs:

Blank CD options

Burn an audio CD

using Windows Media Player
¢ Burn files to disc

using Windows

Set AutoPlay defaults in Control Panel

Y Teble of Contents ) < 3 b
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Attaching Images to Email

You can send images as email file attachments.

@ Procedures \

Click here for most images. ===  Click here when you want to

change the image size or image | Select a task from the left
quality settings, then click side of the window (p. 8):
[Custom Settings] to change [Print & Email] and [Email
settings.

Images].

2 Select an image to send.

® You can also select multiple
images or all images in a folder.

Emnil Sattngs
Bnd hiese images

@ Sl i 3 Click [2. Change Image Size]
LIsing curstom sefings . .
Lise Bin ook b stech S S— * You can change the image size
o - and quality settings.
il o iy siza of thiy age Sire Srnall (40480 - . m
: zmluﬂ-sdmnd'a :u:ﬂwﬂy. H';H i 4 CI|Ck [3- F|n|Sh]
T Eme AtochmentSue. ot Galcuisre | ¢ The mail software will start, and

Aher Finrsbng the Task: Launch delaull ermod apphcabon

the send screen will appear. The

T selected image will appear as an
| attached file.

Click here to check the - Click here to preview the *In [Custom Settlngs],llf [Save
options currently set. compressed image. to Folder] is selected in " After
Finishing the Task”, the selected
Click here to check what the images will be saved in the
actual compressed file size will be. indicated destination folder.

~ @ HINT |

Automatic Start-up Settings for E-mail Software

e \When using Windows Vista, configure the settings in your e-mail software. For example, you can
configure Windows e-mail by starting e-mail, then clicking the [Tools] menu, followed by [Options],
[Default Messaging Programs], [This application is not the default Mail handler], and [Make Default].
When using Windows XP, settings can be configured by starting the Internet Explorer program, and

clicking the [Tools] menu, followed by [Internet Options], [Programs] tab, and the [E-mail] pull-down

menu.
\. J

(1) IMPORTANT

* The e-mail’'s MAPI client must be preset for the e-mail software to start
automatically.

¢ If the e-mail software does not start automatically, first save the images to your
computer, then start your e-mail software to attach and send the images. The
destination folder for saved images can be set with [Custom Settings].

(A Teble of Contents ) <« 7 )
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Slide Shows

Viewing Images in Slide Shows

A multiple selection of images can be shown at full size on the screen in succession as

a slide show.
You can freely configure the T A\
transition effects, information % Procedures
displayed and display time settings. | Select a task from the left

side of the window (p. 8):
[View & Classify] and [View
as a Slide Show].

ST

~ @ HINT ~

Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing.

You can set the Star

Rating for an image
while it is displayed. Rewind Pause Forward

After the slide show, After the slide show, Stops the slide show.
the images you the images you clicked
clicked during the during the show appear
show remain selected. in a printing window.
\_ ,

=

(A robte of contents < 33 p)
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Image Management

Changing File Names in Batches

You can change the file names of multiple images in one procedure.

@ Procedures\

"& .
82 | Select a task from the left
side of the window (p. 8):
Name + Number) [View & Classify] and
4 [Rename Multiple Files].
‘S:“t'"g Date + Number | « You can change individual file and folder

names by clicking the [File] menu and
selecting [Rename] or by clicking on the
file name in Preview mode.

e Changing the image name in
ZoomBrowser EX also changes the actual
file name on the disk.

Name + Shooting Date + Number l Change randomly
numbered images

Shooting Date + Name + NumberJ and received images

into consecutively
numbered images.
vV —

xxx_03 xxx_05

Sorting Images into Folders by Shooting Date

You can sort images into folders by their shooting dates.

@ Procedures \

| Select a task from the left
side of the window (p. 8):
[View & Classify] and

— 2000/05/16 [Classify into Folder].

> .

Images predating your use J

4

of ZoomBrowser EX can
also be managed together.

(A Tebvle of Contents ) < 3 p)
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Configuring Image Information Settings

Setting Star Ratings

You can set the Star Ratings used in searching and displaying images in the index list.

@ Procedures )

| O

Switch to [Preview Model.
7 Set [Star Rating].

e You can also set the Star Ratings by
accessing the [Edit] menu, the Properties
Window or the Viewer Window.

Y r 7 : Ultimate
% :Moderate
w : Okay

Inserting Comments

You can freely insert your choice of text as Comments.

@ Procedures )

| O

Switch to [Preview Mode].
7 Insert [Comment].

e Comments can also be managed in the
Properties Window.

Your choice of text
as comments

€ @xETD < w0 >




Assigning Keywords

More Advanced

You can set Keywords for use in image searches.

\.

~ @ HINT

About Image Information
This chart shows the information other than shooting information that can be added to images.

Techniques

@) Procedure
1

e Keywords can also be managed from the

~N

S

O

Switch to [Preview Mode].
7 Insert [Keywords].

[Tools] menu or Properties Window.

® To add keywords,

click the [Tools] menu

and select [Manage Keywords].

Information Type

My Category

Star Ratings

Comments

Keywords

Content

Categories such as
People, Scenery, etc.

Categorized on a
basis of 3 rankings:

Text input without
restriction regarding
the shooting
circumstances

Selections are made
from a list (editable)
of keywords, such

as the photographic

W, WK, R : .

or associated subject, place or

memories. action.
Configuration Configured in : .
Method Y .2 Configured in ZoomBrowser EX
Used in Searches — 0 0 O
Us_ed as Filter 0 0 o o
Criteria
Display beneath
Thumbnail O 0 0 -

Categories displayed beneath thumbnails can be selected by clicking in the Display Control Panel.
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Searching, Filtering and Sorting Images

Searching Images

You can search images using parameters extracted from the information associated
with them.

@ Procedures \

] Select a task from the left
side of the window (p. 8):
[View & Classify] and
[Search].

e After a search, the correlated images
display in the [Search Results] folder.

-
' Favorite Folders | Al F.:.I.:Ier_sl

- Jy 2009_08_08 -

.. |, 2009 08 09
.| 20090810

----- | Search Results =

[ Add... ] | Remave |

@ HINT

Tasks Related to Search Results
You can select images in the [Search Results] folder and perform operations on them, such as printing or

copying them to other folders.

(1) IMPORTANT
e Please note that deleting an image from the [Search Results] folder deletes the
original image. Use caution in deleting items from this folder.

(A Tebvle of Contents ) < 2 p)
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Filtering Images

You can use filters to display only images meeting the selected parameters in the
Browser Area.

@ Procedures\
1

[Filter]

2009 ot @ {_? | & -0 '_I_[EIE'A. - R

Fibes by Shw g W ®rr Worory

This section is used to specify the filter criteria.

Sorting Images

You can sort images in the Browser Area based on the specified parameters.

@ Procedures\

il mbdit ook imeniem i

[View] and [Sort by].

Modification
Date

Star Rating

Ascending/
Descending
Order

< 3 )
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Comparing Images

Comparing Multiple Images

When a good photo opportunity arises, you can shoot the same subject using different
shutter speeds and exposures. In ZoomBrowser EX, it is easy to compare images so that
minute differences can be detected.

@ Procedures\

| Select several images to
compare.

2 CIick@[View Image].
3 Select —, [ [ | [I[] or=Hin

the Viewer Window.
4 Click [€5] [Synchronize].

e Selecting [Synchronize] causes actions
such as increasing/reducing the
magnification level or scrolling around
the image to apply to all of the selected
images in lock step, making it easy to
check minute details of focus, coloring
and other image characteristics.

Zoarm Fatiee BN

Actions performed on an image, such as scrolling or changing the
magnification, are performed on the other image as well.

(A ebre of Contents ) < 4 p)
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My Camera Settings

Changing the Shutter Sound and Start-Up Image

You can select from dedicated screens to register to the start-up screen that appears
when turning the camera on, and dedicated sounds to register to various camera
operation sounds (My Camera Settings).

My Camera Settings @ Procedures\

e Start-up Image

« Start-up Sound | Connect the camera to the
e Shutter Sound computer.

e Operation Sound

. Seplftimer Sound 27 Turn on the camera power,

and set it to playback mode.

3 Select [Downloads Images
From Canon Camera using
Canon CameraWindow].

Select [Canon
CameraWindow] when using
Windows XP.

4 [Camera Settings]

Select the desired item from
the following and make
settings.

» [Set Start-up Image]
» [Set Sounds]
» [Set Theme]

(1) IMPORTANT

e My Camera Settings are only available on certain models, when [Camera Settings]
displays in CameraWindow.

e With Windows Vista, the settings files originally supplied with ZoomBrowser EX
cannot be deleted.

(A oot of Contents ) <« s )
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My Camera Settings
registered in the camera.

My Camera Settings

Canan

You can register the
start-up image, start-up
sound, shutter sound,
operation sound

and self-timer sound
collectively if you select
[Theme].

After choosing a My Camera Settings file from the left-hand list,
select a My Camera Settings file to replace in the right-hand list
and click this button to register it in the camera.

@ HINT

Downloading My Camera Settings Files
You can download various files to use in My Camera Settings from CANON iIMAGE GATEWAY.

(A oot of Contents ) < % p)
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Transferring Images

Transferring Images to a Camera

Images transferred once to a computer can be transferred back to the camera.

@} Procedures\

| Connect the camera to the
computer.

27 Turn on the camera power,
and set it to playback mode.

3 Select [Downloads Images
From Canon Camera using
Canon CameraWindow].

Select [Canon
CameraWindow] when using

Show favorite images I
to friends or connect
a TV to show them

on a large screen. Windows XP.
P 4 [Organize Images on
Camera]

5 [Organize Images]
6 F(Upload) —_—

(1) IMPORTANT

e Cameras that use the “MOV” data type
can play back movies transferred back to
the camera if movies were taken with that
camera. Refer to the “Data Type” item in
“Specifications” near the end of the Camera
User Guide to see if the camera uses the
“MOV” data type. You may not be able
to play back movies taken with another

/ Select images.

e If the Main Window is open when the
camera is connected (directly after

camera_. . . . . transferring for instance), open the

e Only still images compliant with Design rule CameraWindow (menu screen) by
for Camera File system standards can be clicking the [Acquire & Camera Settings]
transferred to your camera’s memory card. task button, followed by [Connect to

Cameral.
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CANON IMAGE GATEWAY

About CANON iMAGE GATEWAY (for U.S.A. customers only)

CANON iMAGE GATEWAY is an online photo service for the purchasers of this product.
Registering online allows you to use the various services.

(1) IMPORTANT
e Internet access is required to use CANON iMAGE GATEWAY (You must already
have an account with an Internet service provider (ISP), browser software

installed and an Internet connection).
e See the homepage for information regarding browser versions (Microsoft
Internet Explorer, etc.) and settings to best connect to CANON iMAGE GATEWAY

online photo services.
* Any ISP account charges and access fees must be paid separately.

Registering
First, register as a CANON iMAGE GATEWAY member.

s @ rrociue
] Select [CANON iMAGE
GATEWAY] f task
‘K//‘\}\‘ “ g CANON the left of thzovrcinzs:):\{on
i.‘\\\‘ =;_I I '\é A’\TAE%E ,(of)d 3)I;::::c:ilect [Register/
Y

* You can register online using the
supplied CD-ROM. To do this, in the
installer panel, click [Register] underneath
CANON iMAGE GATEWAY.

Canon DIGITAL CAMERA
Solution Disk

Deptad Camecra S0Mmave
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Available Services
CANON iMAGE GATEWAY offers a variety of convenient and useful services.

@ Procedures\

fasnen J | Select [CANON iMAGE
4 GATEWAY] from tasks on
the left of the window (p. 8).

Select the desired item from

Create your own photo album the _fOIIOWing and make

on CANON iMAGE GATEWAY settings.

» [Register/Add Product]

» [Top Page]

» [View Online Photo
Album]

» [Upload Images]

» [Download My Camera
Contents]

E-mail notifications
of album uploads

4

Friends and family can
freely browse images

Access even from
mobile phones

Order prints
Order an original

collection of photos

My Camera Settings Files on
CANON iMAGE GATEWAY

N\

Also, you get the g
latest customer £

- support information,

- just for registering

— your product

Download files for My Camera
Settings (certain models only)
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Preference Settings

Customizing ZoomBrowser EX

You can configure ZoomBrowser EX to operate according to your preferences.

- e Overall themes, such as @ Procedures\
P L window appearances -
- : ° Processing me tho ds for 1 Ih .-‘ :._=E-:I I;. ) -EI-:::!L. i A% 'I"-";";nil'n -
. 7 images shot with the File Edit View -Touls Internet  Help
s | e et (File Edit View { Tools ) Internet  Help
e * Categories of shooting [Tools] and [Preferences].

information displayed
e Show/hide messages

e Print settings
e Zoom speed I

Customizing the Task Buttons

You can hide items that you do not usually use to streamline the task buttons.

— @ Procedures \
[ vevs o | o ol4-0- File Edit View (Tools) Intemet Help.
e 4 L e [Tools] and [Customizel].
p Edit Image:
N %f Sich Photos
. r‘f" Bt
‘ﬂ] Pint 4 Emad
‘@1 CANON MAGE GATEWAY
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List of Available Functions

CameraWindow Functions

Function Names Description of Function Page
Imporntanseredlimages Only transfers images from the camera that have 0.9
Import Images not yet been transferred.
from Camera Select Images to Import Only transfers chosen images from the camera. p. 11,17
Import All Images Transfers all images from the camera. p. 11
Organize Images Protect, rotate, and delete images on the camera.
9 9 Organize Images Also transfers images back to the camera from your | p. 18, 47
on Camera
computer.
Set Start-up Image Sets the camera start-up screen. p. 45
Set Sounds Sets camera sound effects (start-up sound, shutter 45
Camera Settings sound, operation sounds, self-timer sound). -
Set Theme $ets the camera start-up screen and sound effects 0. 45
in My Camera Settings.
Sets the camera owner name, and start-up screen
General . p. 16
when CameraWindow starts.
Preferences , : —
Sets the automatic transfer settings and destination
Import p. 10, 11
folder.
ZoomBrowser EX Functions
Task Button Names Description of Function Page
Connects to the camera to open CameraWindow
Connect to Camera . . —
(menu screen), and use CameraWindow functions.
Acquire & Acquire Images from Memory Transfers images from a memory card. You can also 1
Camera Settings | Card select images on the memory card and print them. -
TTanerermageselMemorylCard I;argsfers images from the computer to a memory |
View as a Slide Show Starts a slide show of the images selected in the 0. 38
Browser Area.
e MRS Changes the file names of the selected images in a 0. 39
single pass.
Glassify inta Folder fClla(i<,5|f|es images and saves them into a specified 0.39
View & Classify older.
Performs image searches using criteria such as the
Star Rating, modification date, shooting
Search date, comments or keywords. Star Ratings, 4
comments and keywords can be set in the image -
information column in the Preview Mode or in the
Properties Window.
(M I( Table of Contents ) 4\‘ 51 >\
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Task Button Names Description of Function Page
Allows you to perform image editing, such as
Edit Image cropping, Image correctlon, Inserting comments, 0.24
and red-eye correction. You can also use it
to start other image editing programs.
Stitch Photos Merges multiple images and creates a single large 0. 29
panoramic image.
Edit Edits movies or still images strung together. You
Edit Movie can add text as titles, or background music, p. 30
and apply various effects.
Converts RAW images into JPEG or TIFF images.
Digital Photo Professional - You can adjust the image brightness, contrast 31
Process RAW Images and color balance among other attributes during -
conversion.
Export Still Images Allows you to change the image size or type, 0. 33
and export it as a new image.
EXComHoues Allows you to change t_he movie size or type, and 0. 33
export it as a new movie.
Extract frames from a movie Extracts still images from movies over a specified 0 34
c interval and saves them as image files.
xport Allows you to select the necessary data from the
Export Shooting Properties shooting information and export it as a text p. 34
file.
Export as a Screen Saver Exports the image as a screen saver file. p. 35
Export as a Wallpaper Exports the image as a wallpaper file. p. 35
Backup to CD Copies images to a CD-R/RW disk for backup. p. 36
Photo Print Prints one image per page. You can print photos 0. 12
easily.
Index Print Lmes up small versions of the images in rows and 0. 14
prints.
Print & Email Print Using Other Software Select the software to use and then print. p. 13
Converts the selected images to the appropriate
Email Images size for transmission by e-mail. You can also 37
g use it to automatically start an e-mail program after -
conversion.
Register/Add Product Conne;ts to.CANON IMAGE GATEWAY and opens 0. 48, 49
the registration page.
Top Page Connects to CANON iIMAGE GATEWAY and goes 49
prag to the top of the page. -
CANON IMAGE | View Online Photo Album Siinge§t§|ﬁi§§'£§tg“§AGE GATEWAY and 0. 49
GATEWAY Play d
Connects to CANON iIMAGE GATEWAY and
Upload Images . p. 49
uploads images.
Connects to CANON iIMAGE GATEWAY and
Download My Camera Contents | downloads images and sounds for use with My p. 49
Camera Settings.

(A ebre of Contents )
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Supported Image Types

The following is a list of image types supported by ZoomBrowser EX.

JPEG (.JPG)

Most cameras use this image type. It compresses at very high ratios, taking advantage
of the characteristics of the human eye. However, because it is an irreversible
compression method (part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may become rougher.

RAW (.CRW/.CR2)

This is a proprietary image type provided by Canon. It saves the output of the image
pixels from a digital camera without any deterioration in the quality of the image.
Some cameras might not support this image type.

Windows bitmap (.BMP)
This image type comes standard with Windows. Most Windows programs support it.

TIFF (.TIF)

This is a relatively popular image type. It is widely supported by non-Windows
programs (such as Macintosh).

PhotoCD (.PCD)
This is the image type used for Photo CDs.

AVI (.AVI)

Standard Windows movie type. The movie thumbnail and a movie icon show in
ZoomBrowser EX’'s Browser Area.

MOV (.MOV)

Movie type. The movie thumbnail and a movie icon show in ZoomBrowser EX’s
Browser Window.

=
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to
delete the programs from your computer or when reinstallation is required to fix
corrupted files.

1) IMPORTANT
e Computer administrator status is required to perform the following operation.

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.
You can remove other programs with the same procedures.

" Click the Windows [Start] menu XO00000X
and select [All Programs] or . W i
[Programs], followed by [Canon |, CANON iMAGE GATEWAY Task Recent Items
Utilities], [ZoomBrowser EX] and e s

[ZoomBrowser EX Uninstall]. Personal Printing Guide

PhotoStitch
OO

) ZoomBrowser EX
ﬁ ZoomBrowser EX

combrowser EA Readme

Metwork

Connect To

Control Panel

'?t“..' ZoomBrowser EX Uninstall

Default Programs

Help and Support

———

The uninstall utility will start and remove ZoomBrowser EX.
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Memory Card Folder Structure

Images on the memory card are in either the [DCIM] folder’s [xxx___mm] folder, or the
[xxx_mmdd] folder (xxx: numbers 100 to 999, mm: shooting month, dd: shooting day).

— J__J_

DCIM XXX___mm
or
xxX_mmdd

IMG_xxxx.JPG (JPEG images)

_MG_xxxx.JPG (JPEG images recorded in the Adobe RGB color space)
IMG_xxxx.CR2 (RAW images)

_MG_xxxx.CR2 (RAW images recorded in the Adobe RGB color space)
STx_xxxx.JPG** (Stitch Assist mode images)

MVI_xxxx.MQOV, MVI_xxxx. THM* (Movies)

MVI_xxxx.AVI, MVI_xxxx. THM* (Movies)

" The folder that holds the settings files

for images in the DCIM folder.

CANONMSC
- " The folder created when DPOF settings are set.
It holds the DPOF settings files.

MisC

e * These files are the thumbnail image files for the camera’s index replay mode. If
you delete these files, you will be unable to transfer movies to the camera from a
computer.

® The “xxxx" in file names represent four-digit numbers.

e Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,”
which is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

e All folders except the “xxx__mm" or “xxx_mmdd" folders contain image settings
files. Do not open or delete them.

e Depending on the camera, some data types cannot be recorded.
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section?

See “System Requirements” in the Camera User Guide.

Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also check to
ensure that you are using the correct cable and that it is securely attached at both
ends.

Are the camera and computer in the correct modes to transfer data?

Some models require the camera to be set to the playback mode to transfer data. See
the Camera User Guide for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. You are
recommended to use an AC adapter (sold separately) to power the camera when it is
connected to a computer.

=
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Problems

Try the suggested solutions to the common problems listed below.

Add New Hardware Wizard displays when the camera is connected to the
computer with an interface cable.
Click [Cancel] to close the window. Temporarily disconnect the camera from the

computer. Next, read Start by Checking This on the previous page and resolve the
problem.

Camera not detected, Events dialog won’t display or images will not
transfer to the computer (when camera is connected to the computer via
an interface cable).

The camera may have been recognized as another device under the following
circumstances.

® The [Scanners and Cameras] icon cannot be found in the [Hardware and Sound]
within the [Control Panel] or the [Printers and Other Hardware] window.

e Your camera model name, [Canon Camera] or a camera icon does not display when
[Scanners and Cameras] icon is clicked.

Solution:
Delete the device with the following procedures.

(1) IMPORTANT
e Computer administrator status is required to perform the following operation.

| Display the [Device Manager] dialog.

Windows Vista:

Click the [Start] menu, [Control Panel], [System and Maintenance], [System], and Task list
[Device Manager].

Windows XP:

Click the [Start] menu, [Control Panel], [Performance and Maintenance], [System],
[Hardware] tab, and the [Device Manager] button.

(A bre of contents ) 45>
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7 Click the [+] symbol beside the [Other devices], [Portable Devices] and/or
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories if it is being
recognized as an “other” device.

File Action View Help

£ Device Manager

File:  Action Miew Help

--ﬂE.I Computer

-y Disk drives

q Display adapters

L) DVD/CD-ROM drives
E.H Floppy disk drives

hg Floppy drive controllers
% Hurman Interface Devices
-Gy IDE ATAJATAPI controllers
E Keyboards

a Mice and other pointing devices
- Bl Monitors

ﬂ Sound, video and game controllers
C— Storage controllers

--qEJ System devices

i Universal Serial Bus controllers

= m HEle |~ m & @
Eld; HHHXK EQ

[+ Computer

EI ago Disk drives

EI § Display adapters

o DVDICD-ROM drives

EI =) Floppy disk contrallers

EI 1.‘ Floppy disk drives

Eﬁ Human Interface Devices
423 IDE ATAATAPT contrallers

" llers

Elal Imaging devices
C LSl Canon KRERRRES

El Mice and other pointing devices
E| Manitars

E| -E8 Metwork adapters

Y Ports (COM&LPT)

Eﬂ. Processors

EIGJ’ Sound, video and game controllers
[+}&e® Starage valumes

E| W System devices
[+ Universal Serial Bus controllers

There are other potential reasons for the problem if the [Other devices], [Portable
Devices] or [Imaging devices] categories do not appear or your camera model name
or [Canon Camera] does not appear. Proceed to Step 5, and temporarily quit the

procedures.

3 Select your camera model name or [Canon Cameral], right-click and select

[Delete].

4 Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it appears in one
or more places in the [Other devices] or [Imaging devices] categories.

5 Close [Device Manager] or [System Properties].
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Disclaimer

e While every effort has been made to ensure that the information contained in this guide
is accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

e No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, memory cards, personal
computers, peripheral devices, or use of non-Canon memory cards.

CDP-E080-030 © CANON INC. 2009
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